I imported an ASCII file and all mv fields are mixed up!
The order of the fields in the file to be imported must be the same as the
order of fields in AFS: Header, First name, Last name, Title, Company, Addressl, Address2, Address3, City, State, Zip, Country, Phonel, Phone2, Memo.

ucceJ.,4

Also, if you have fields missing on the ASCII file (for example, there is no
Company field) then be sure and deselect those fields from the window that ap-

Desktop Mailing Database for the Apple IIgs®

pears when you attempt to import an ASCII file.

I made some changes to one of mv entries using the List
Editor window. but the address hasn't changed in the list
window!
You forgot to press the 'Change' button on the list editor window after
finishing your changes. If you haven't closed the List Editor window, go to it by

Written by Michael Lutynski
© 1993 Michael Lutynski
© 1993 Econ Technologies, Inc.

pulling down the windows menu and selecting List Editor. If you see the entry
you modified displayed there on the list editor window, along with the changes
you've made, then press the 'Change' button. Otherwise, you will have to make
the changes again - and be sure to press the 'Change' button.

First Printing, November 1993

Econ Technologies, Inc.
P.O. Box 195356
Winter Springs, FL 32719
(407)~365$4209

F-4

TM

Reference
Credits
Software Design and Development
Michael Lutynski

Mv address won't fit inside the label!
First, choose the "Show Cell Boundaries" from· the layout menu. Next,
from the layout window, select the address by using the mouse and dicking on
any portion of it and then dragging it so that it fits inside the label better. Also

Manual Design

look at other cells to see how various addresses fit in the cells (i.e., some street

Karen Proni

addresses are longer than others). You can reposition your pictures in the same
manner. It is a good idea to keep your pictures above or to the left of your ad-

Copyright
Copyright 1993 Michael Lutynski and Econ Technologies, Inc
All rights reserved.

Trademarks
Apple Ilgs and Finder are registered trademarks of Apple Computer, Inc.
AppleWorks GS is a registered trademark of Claris Corporation.
All other brand and product names are trademarks of their respective companies.

License
This warranty applies to the original retail purchaser only. To obtain the warranty offered,
the enclosed Registration Card must be completed and returned to Econ Technologies, Inc,
within 30 days of purchase. Econ Technologies, Inc. retains title to Addressed For Success
(the "Software") and to the Addressed For Success User Manual (the "Manual"), The
Software may only be used on a single computer, and you may make one copy of the disk for
backup purposes only.
Econ Technologies, Inc. warrants that, under normal use, the disks on which the Software is
stored is free from defects in materials and workmanship for a period of 30 days from the
original date of purchase.
Econ Technologies, Inc. makes no warranty orrepresentation, either express or implied, with
respect to the manual or the software; their quality, performance, merchantability, or fitness
for a particular purpose. As a result, the software and manual are sold "as is," and you, the
retail pw·chaser, are assuming the entire risk as to their quality and performance.
The Software and the Manual are fully copyrighted works. You may not decompile, reverse
engineer, disassemble or otherwise reduce the Software to a human perceivable form.

dress field. This way you can be sure it won't be overwritten by a long address.
After repositioning your address, if it still does not fit you might consider
changing the font size. Keep in mind that ornate fonts will be harder to read as
the font size becomes smaller so you might consider using a plain font when
choosing a small size.

The return address is not showing up on the layout window!
Under the Elements menu, make sure that the "Return Address" item is
checked. If this doesn't solve the problem then make sure that 'Clip Elements to
Boundaries' is not checked in the Cells menu, and then see if the return address
shows up outside the area of the label. If you still can't see a return address then
make sure you have one defined. If the 'Return Address' item in the Elements
menu is dimmed, then you do not have a return address defined. Go back to the
list window to define a return address.

I typed a very long name/address!citv!etc. and I can't see all
of it in the list window!
Use the left and right arrow keys to move past what you can currently see, and
the field will 'scroll' as you do so.

Under no circumstances, including negligence, shall Econ Technologies, Inc. be liable for
any incidental, special or consequential damages that result from the use or inability to use
the Software or related documentation, even if Econ Technologies, Inc. or an Econ
Technologies, Inc. authorized representative has been advised of the possibility of such
damages. Some states do not allow the limitation or exclusion of liability for incidental or
consequential damages so the above limitation or exclusion may not apply to you. In no event
shall Econ Technologies, Inc. 's total liability to you for all damages, losses, and causes of
action exceed the amount paid by you for the Software.
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AFS allows you to perform a bulk sort on your list so that you may rake advan-

A2.
A3.
A3.

tage of discounts offered by the United States Postal Service. Visit your nearest
Post Office for full details and instructions on bulk sorting before you attempt to
do a bulk sort mailing. There are rules and conditions that must be met in order
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necessary paperwork.
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Appendix B-Troubleshooting
Mv clip art disappeared from the lavout window!!

c

ments to Boundaries" is checked, the dip art will not be displayed. If this is not
the problem then it could be that the lines in the picture, when scaled down, result in them disappearing. Try a picture with thicker lines, or a smaller picture.

C7.
Under the Cells menu, make sure that tbe "Clip Elements to Boundaries"

item is not checked. To see where the cell boundaries are, make sure that under
the Cells menu you have "Show Cell Boundaries" checked.

The 'Choose Font' option is dimmed. what do I do?

D

the layout window by simply clicking on it You will see a gray rectangle appear
around it. You

can then 'Choose Font'
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In order for this option to be active you must first select your address in
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You're clip art may be off the cell boundaries, in which case if the "Clip Ele-

What Addressed For Success Can Do
What You Need
Installing Addressed For Success

Appendix A: Troubleshooting
Appendix B: Bulk Sort Notes

Addressed For Success
The following menu items' field names correspond to the fields in every
address. If the menu item field name is checked, then the fiel<;J will be displayed
within the address. If not checkb:i, then it will be omitted. For example, small
labels will not be able to fit an fields, so it is wise to uncheck Title, Company,
Phone 1, and Phone 2. There is no Memo menu item because the Memo field,
by its very nature, is too free-fonn and suggests no logical way to appear in a

cell-formatted layout

Header

First Name
Last Name
Title

Company
Address 1

Address2
Address 3

City
State

Zip
Country
Phone 1
Phone2
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Addressed For Success
Welcome

Address Menu

Thank you for purchasing Addressed For Success™! We hope that this product

Choose Font...

will help you achieve more out of your Apple Hgs system. Please be sure to re-

This function is only available if either an address element or a return

turn the registration card. By doing so, you'll be able to receive technical sup-

address element is selected in the layout window. To select either one simply

port and notices of future updates and products. AU suggestions, praise, and

dick on it You will see a gray rectangle appear around the selected item. After

criticism regarding this, or any other Econ Technologies product, is welcomed.

selecting 'Choose Font..' from the Address Menu you will see a dialog box displayed, which allows you to change the font of the selected list address or return

We set out. to develop an easy to use, desktop based address database and label-

address in the Layout window. The font change is applied to all the cells. Note

ing program, something every Apple IIgs owner who makes labels can use. We

that the list addresses and the return address can have different fonts.

are proud to bring Addressed For Success to the Hgs market and hope you wi.H
benefit from its capabilities!

Display as UPPERCASE

What Addressed For Success Can Do

This option, when checked, displays all addresses as uppercase. This only

affects the way the address is displayed, not stored in memory. This option was

Addressed For Success is a desktop address database and labeling program. Its

added to AFS because the United States Postal Service prefers uppercase ad-

primary intended use is for entering and storing addresses, and printing labels.

dresses since they can be more easily sorted by their scanners, but lowercase is

1be best feature of AFS is the layout window, where you can define your labels,

acceptable. Check with your local Post Office for more details.

and see exactly how they will appear before you print. Since you can exactly
define the dimensions of your labels, AFS will work with any label size.

Display ZIP with +4
This option, when checked, displays all United States addresses' ZIP

With a little imagination you can make AFS print much more than just address

codes with the +4 extension if there is not already a +4 extension present. Since

labels. You can use it to make disk labels, VCR tape labels, name badges, and

AFS does not know what the correct extension is, it makes it '0000'. 1bis only

much more. If you cannot find the exact size label you need, you can purchase

affects the way the address is displayed, not stored in memory. The postal ser-

labels that are basically one very large label per sheet, and cut out the labels to

vice prefers ZIP+ 4 addresses because they can be more easily sorted by their

the desired size after they are printed.

scanners. Check with your local Post Office for more details. Note that when
you choose this option, the barcodes will also increase in size and may not fit on

You can also use the database capabilities of AFS to print subsets of your li~t.

your labels if the labels are small. Also, the barcodes that you see in the window

For example, if you keep a list of all friends and relatives you may enter each

are exactly what will appear on the printed page.

person's birthday in the memo field, such as 'Bday Jan l ', 'Bday Dec 15',
'Bday Jul 29'. At the end of November you can search your Hst for all addresses
where the memo field contains 'Bday Dec' and print out these labels so you can
send everyone whose birthday falls in December a birthday card.
As you can see, the possible ways to use AFS are only limited by your imagination.

A-2
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Getting Started
What You Need

Scale Pictures...
This option allows you to scale and previevy pictures you have pasted
into the AFS layout. First you must select the picture on your layout window by
clicking on it, in order for the Scale Pictures ... option to become available to
you. After you select 'Scale Pictures .. .' a large window shows up in the screen.
The Preview section, located on the left side of the window, gives you a preview

Addressed For Success runs on an Apple Hgs with a minimum 1.5 mb of RAM,
Finder 6.0 and System Software 6.0. If your computer is running an earlier version than 6.0, you will need to upgrade to 6.0. Addressed For Success will NOT
work with earlier versions. See your favorite Apple II dealer for the complete
System Software 6.0 update.

of the picture. The Scale section, located on the right hand side of the window,
gives you two

ed~t

fields where you may enter lhe horizontal and vertical scaling

Installing Addressed For Success

desired. You can use the mouse to position the cursor or tab to go move from lhe
Installing Addressed For Success is very easy if you follow these steps:

firsl to the second edit field.

Installing in a system with two floppy drives or a hard
drive
Scale Pictures ...
... PrevieN .................................................. ... Scale ..................................... .
1 ~m~
Happy iLrtni Iso
1% Horizontall11

i

!

l. Insert the Addressed For Success disk into your computer's disk drive. An
application named AFSJnstall wm appear on your computer's desktop.

2. N<?w launch the application AFS.InstaH by double clicking on its icon. See

(

Preview

)

figure 1.
3. The Addressed For Success installer will prompt you to enter your name and
the name of your organization, as shown in figure 2. These names will get recorded permanently onto your Addressed For Success program, so choose some-

( Cancel

thing appropriate.

Figure 23. Scale your pictures and preview the results here.

Rm.vu ~El~
ProDOS 6 items 77

~D~

fr

Figure 1. This window shows up after the
Addressed For Success disk is inserted in

AFSinst11l l
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the disk drive.
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Reference
Postal Bar Code

••
J••• Um name: II
•• Organization: [
••
••
(

H~JJMUeJ
•
for
HSacceu )

Please personalize your copy of
Addressed For Success'" by entering
your n(JDe and organization (if any).

This item, when checked, displays a postal bar code in every cell that has
an United States address with a ZIP code. If an address has something in its

I

J

Country field, then it is assumed the address is not United States and thus there
will be no bar code. Barcodes for ZIPs that have 5 digits will fit most small labels. However, ZIPs that have 9 digits exceed most small label widths. Be sure

Quit

) ( Canti nue )

and do a visual check of your layout window to see that the postal bar codes will
fit.

Figure 2. Enter the appropriate information at this screen.
After entering your name and organization name (if applicable), press the Continue button.

II1I11111II11II11 ,, ,,, ,,,,, ,,,,,

5. If you wish to quit the installation process, press the Quit button.
Next, the dialog shown in figure 3 will prompt you to choose the volume where
you want Addressed For Success, and the Avery Label Templates installed. By
default, the startup volume of your GS will be listed. If you want to install Addressed For Success on a different volume, press the Next Disk button. You can
continue to press the Next Disk button until the name of the desired volume is
listed in the dialog.

Figure 22. A typical postal bar code.
Picture #1

This item, when checked, displays picture #1 in each cell. In order to
have a picture available to you in AFS you must copy if from another program,
then go to AFS and while in the Layout window select paste from the Edit
menu. Figures are numbered in the order in which they are pasted.
Picture#2

••
J •••
••
•
10 •
J ••

H~JJMned
for

•

HS««tU '

Install:
[81 Rddmed for Success Application
[81 Avery Label Templates
Onto Volume:
•:sustemOne'"
( Next Disk ) (

This item, when checked, displays picture #2 in each cell. See above for
more details.
Picture #3

This item, when checked, displays picture #3 in each cell. See Picture #1
for more details .

Quit ) ( Install )

Figure 3. Choose the volume where you want Addressed For
Success installed from this window.

A-4
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Cells Go Left to Right

Getting Started
Once you've selected the desired location, press the Install button. Addressed

Selecting this option togg!es it on and off. If the option is on, then AFS

For Suc<;:ess wm display the message shown in figure 4 once installation is c;om-

will arrange the List's addresses so that they proceed from left to right, and then

plete. Press the OK button and AFS will return to the previous window. You

top to bottom along the page.

may install it on any other volume by performing the same steps again. When
done press the Quit button.

Cells Go Top to Bottom
This option, when checked, arranges the List's addresses so that they
proceed from top to bottom, and then left to right along the page.

Installation onto the vollllle ":SijstemOne• has
been successfullu completed!

Elements Menu
The first five items in this menu are toggled on and off by selecting them. When
an item is toggled on it will have a check mark to the left of it. If it is toggled
off then it will not have a check mark.

Figure 4. Addressed For Success displays this message after a successful installation.

Installing in a system with a single floppy drive

List Addresses
This item, when checked, causes I.he List's addresses to be displayed,

1. Complete steps 1 - 4 from above.

and therefore printable, in the Layout window. This option can be useful if you
want to print a bunch of labels that you can use for return addresses in your cor-

2. Press the Quit button.

respondence (such as on your bills). You would have List Addresses toggled
off. and you would have a return address specified and toggled on (see follow-

3. Now use your favorite disk copy utility to make a copy of the entire AFS disk.

ing). To make it even nicer you could paste a picture on these labels.

You can then run AFS off the duplicate disk. Never run AFS from the original
disk - put it in a safe place in case your copy becomes damaged.

Return Address
This item, when checked, displays the List's one return address in every
cell, in addition to the normal list address. Even though you have a return address specified you still have a choice whether you want it to print or not by
means of this option which can be toggled on or off.
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Clip Elements to Boundaries
Selecting this option toggles it on and off. If the option is checked/on,
you will see a check mark to the left of it When checked, the layout window
will not display any print that falls outside actual label, as defined by using the
Set Cell Dimensions function.
La~out.1

Horiz: 0 01 O"

Vert: O 01 O"

04' <?? <l>O

Rick l\mieka
5673 Oak Ridge Nfl

Anders Bachman
4882 Chiroineas Avenue

Apt B

Northridge CA 91325

l'nm~?n~~ Dor~

Page:

1 of

2

LIT AQ'.l?I

l11ll1l11l1l11l111l1l111lll11l1I

l1ll11ll111ll1111l11l1l1\11l1\1I

John-Paul Boisvert

Colleen Burbank
12382 Beverly Place
Lake Forest IL 60045

PO Box 459
Aroory MS 38821

Figure 21. This is the same layout as shown in Figure 20, with Clip Elements to
Boundaries toggled on. Notice that you need not have cen boundaries showing
in order to clip the elements to boundaries.
Note: If you cannot see an element, perhaps because you made the picture too
large, or the font of the address is too large, or you've simply placed the element outside the area of the cell, uncheck this option so that all elements will
be visible even though they're "out-of-bounds." You can then select the ele-

ment by clicking on it on the layout window, and moving it with your mouse. If
an address, you can select it by clicking on it. You could then use the Choose
font option from your address menu and make the font smaller. In the case of a
picture you can select H by clicking on it, and you could then move it or change
its size (see the Elements menu item Scale Pictures ... )
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..~. ~,,.;~u f·ut
size you entered in the Set Cell Dimensions ... function. We suggest you keep
this option check, siµce it is a valuable tool in viewing how your addresses fit to
the labels.

m

la~out.1

Horiz: 0 01 0"

\lert: 0 01 0"

ll1' 1'? ?O

Page:

1 of

2

!ll111lll111ll1111ll1111fr

Anders Bachman

Rick Amieka

5613 Oak Ridge NW
4882 Chimineas Avenue
lbrthridge CA 91325
Apt B
GG!ffitoek·Park·Ml·
4n2+
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ! i;K;ff1·;xi;;·;·;r;1I;r;r;;I;ir · · · ........... · ·
11ll1l11l1l11l111l1l111lll11l1I

John-Paul Boisvert
MS

11896 10th
fKenner LA
I

1.......................................... .

I Colleen Burbank
12382 Beverly Place
I.&e Forest IL 60045

PO Box 459
Aroo

!Fmi.ly Barr

38821

Figure 19. The cell boundaries are showing. You can now clearly see that the
address is too long and wm have to be modified.

m
Horiz: 0 01 0"

layout.1
Vert: 0 01 0" 01'

Rick illnie ka
S673 Oak Ridge NW
Apt B

<?? ?D

Ande rs Bae hman
4882 Chimineas Avenue
Northridge CA 91325

Comstock Park MI 49321
l1ill1l11l1l11l111lil111lll11l1I

l1ll11ll111ll1111l11l1\1!11l1l1I

John-Paul Boisvert

Colleen Burbank

PO Box 459
Aroory MS 38821

12382 Beverly Place

Lake Forest IL 60045

Figure 20. The cell boundaries are not showing.
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Reference
Unmark Return Address
Causes no return address to be specified.

AFS is primarily designed to maintain a database of names and addresses and to
allow easy printing of labels. As such, it gives you fifteen named fields for each
entry of your database:

List Info ...
Displays a dialog box with infonnation about the List, like the number
of addresses, the number of selected addresses, the return address (shown by

1. Header

First and Last name), whether the list is postal bulk sorted, and the size of the

2. First Name

list.

3. Last Name

4. Title
5. Company

list Info ...

6. Address 1

Addresses: 37

7. Address 2

Selected addresses: 1
Return address: Hone
Memory used: ~K

8. Address 3
9. City

10. State

List is bulk sorted:
Hisit bulk addresses:
3-Digit bulk oddrmes:
State bulk addmses:
Hixed states bulk addresses:

11. Zip

12. Country
13. Phone l

Ho
H/A

NIA
MIR

H/A

Non-USPS addresses: MIR

14. Phone 2

(

15. Memo

Fields I through 14 are 'printable' fields. You can have AFS print any and all

OK

J

Figure 16. A typical List Info dialog.

of these 'printable' fields. The memo field cannot be printed, and you will
therefore never see it in the layout window.

View Menu

Cells

25%

Causes the screen to be displayed at 25% size.

50%

Causes the screen to be displayed at 50% size.

This term is used in the layout window. Typically, your ceU will be the exact

100%

Causes the screen to be displayed at 100% size.

size of your label. You can define the size of your cell when working in the lay-

200%

Causes the screen to be displayed at 200% size.

out window. We recommend that you define your cell to be the exact size of

400%

Causes the screen to be displayed at 400% size.

your label. That is, if you're using a roll of 3-1/2" x 15/16" labels, then your cell
should be defined as a 3-1/2" x 15/16" rectangle.

B-4
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Learning Ti1e Basics
Mark Printable Addresses

Elements

Allows you to specify that the selected addresses ,in the List window will
be visible, or printable, in the Layout window. The check: mark: to the left of the
address in the List window signifies that the address is printable. Alternatively,
just clicking on the check mark toggles the printable/not printable state of the
address.

This term is used in the layout window. Each label/cell displayed in your layout
window may contain any and all of the following elements:
Address - A complete address is comprised of fields l - 14, as mentioned earlier.
However, you may set up your layout so that some fields won't appear in the

This feature is useful in conjunction with Select By Example. Suppose you

layout window, and thus won't be printed.

wanted to only print out all of the addresses from California. First choose Select
AB, then Clear Printable Addresses, and then Select By Example. Type CA in
the State field and click the Select button. The List window will have all of the
California addresses highlighted. At this point, choose Mark Printable Ad-

Return Address - You may designate one of your database entries to be a return
address.
Postal Bar Code - Generated by AFS per user request.

dresses. Now only these marked, printable, California addresses will appear in
the Layout window, ready to be printed.

Picture 1 - The first picture you paste into the layout window.
Picture 2 - The second picture you paste into the layout window.

Unmark Printable Addresses
Allows you to specify that the selected addresses in the List window will

Picture 3 - The third picture you paste into the layout window.

be not visible, or not printable, in the Layout window. The absence of a check

mark to the left of the address in the List window signifies that the address is
not printable.

Mark Return Address
Allows you to specify which one address wm be the return address for
each label or envelope in the Layout window. In order for this option to be active you must have one, and only one, address selected in the list window. Select the desired address, and then pull down the List menu and choose 'Mark
Return Address'. Upon performing this action, the address wm appear red, but
only in the List window, to signify it is the relum address.
Note: Choosing a return address has the side effect of having a label with the
same from and to address. You can avoid this by selecting the return address
from the list window, and then unmarking it as a printable address.
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Change list Sorting Order ...
(2) First Mame

(3) Address 1

{) Up Five

(5) Address 3
(6) CitM
(7) State

0

m Address 2

UpOne

{)' Down One

-0- Down Five

(8) ZIP
(9) Country
(1~) Phone 1
(11) Phm 2

( Cancel )

(12) Header

(13) Title
[]Pasta! Eu ik San

(

Sort

)

Figure 15. Change the sort order definition and perform sorts from this window.
Additionally, two other buttons and one check box are available from the change

Ust Sorting Order window:
Sort - Once you have finished rearranging the sort order list, and are ready to
actually sort the list, press the 'Sort' button located at the bottom right hand of
the window.
Cancel - Exits the window with no alterations being made to the sorting order,
or to the list
Postal Bulk Sort - This check box will only become active when the ZIP field is
the first one on the sort list. This is because the list must be sorted by zip in order for AFS to perform a Postal Bulk Sort If you check this box then AFS will
perform a postal bulk sort when you press the 'Sort' button. Please see your local United States Postal Office for more details regarding bulk sorts, they have
requirements and guidelines which must be met. Also note that a postal bulk sort
may take some time.
Note: Sorting your list by a new sort order will cause the list window to list
fields in the new sort order.
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Edit Address
Brings up the List Editor, where the eptry currently selected in the list
window will be displayed. You can then modify any of the fields. See Insert
New Address for details on navigating in the List Editor window, as well as descriptions on the buttons available. Once finished making changes you must
press the Change button in order for the List window to show the new changes.
Note: Another way to edit an address is to double click on the address in the
List window. This win also bring up the List Editor window.

Edit Return Address
Brings up the List Editor, where the currently designated return address.
will show up. You may make any desired changes and then press the 'Change'

button. See Insert New Address for details on navigating in the List Editor window, as wen as descriptions on the buttons available.

Sort...
Allows you to change the order in which AFS displays the addresses in
the List and Layout windows. Choosing this option displays a dialog box with
a scrollable list of the fifteen address field names on the left hand side. The order of the field names represents the order in which the fields are currently
sorted. To change the sort order you begin by selecting the field whose order
you want to change. You can then use one of five buttons to move the field up
or down in the list:
Up five - Causes the currently selected field on the list to move up five spaces.
Up one - Causes the currently selected field on the list to move up one space.
Down one - Causes the currently selected field on the list to move down one
space.
Down five - Causes the currently selected field on the list to move down five
spaces.
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File Menu
Eight buttons are present at the right bottom of this window:

New
Displays a dialog box where you can choose to begin a new address data-

Change - This will not be active since you are entering a new entry, not chang-

base List or a new page Layout template.

ing a previously existing one.

Open"°'

Add - Enters the data you've typed into the List window, and clears all the fields

Displays a standard file dialog box allowing you to choose a List or a

in the List Editor so you may make another entry.

Layout file to open.
Clear - Clears all the fields/data you've just entered, so you can start over with
this one entry.

Close
Closes the front most window.

Cancel - Causes the List Editor window to close, and no new entries to be made

Save

to the List Editor window.
Saves the current List or Layout session, depending on which of the two
Moves up one entry in the List window, and displays Hs

windows is front most

information in the List Editor window. This is relative to
the currently selected entry in the List window. Note that

Save As...
Saves the current List or Layout session, depending on which of the two
windows is front most, allowing you to specify a new file name.

after entering a new address, it is inserted at the bottom of
the list and this address becomes the currently selected entry.

Import...
Displays a standard file dialog box, prompting you to choose a file to im-

Moves down one entry in the List window, and displays its
information in the List Editor window. This is relative to

port into the current List

the currently selected entry in the List window. Note that
after entering a new address, it is inserted at the bottom of

Export...
Displays a standard file dialog, asking you to write out, or export, the

the list and this address becomes the currently selected en-

List to an ASCII text file.

try.

Page Setup ...

Moves up to the top of the List window, and makes the

Displays a window prompting you to specify the page size in the Layout

first entry the selected entry.

window along with other page options.
Moves down to the bottom of the List window, and makes

PrinL.
Prints the contents of the Layout window.

C-2

the last entry the selected entry.
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Quit

Windows Menu

Quits AFS back to the Finder.

This menu contains a list of an windows currently open in AFS. Choosing one of the windows brings it to the front.

Edit Menu
Undo
Is not implemented within AFS.

List Menu

Cut
Cuts the selected item to the clipboard.

Insert New Address
After choosing this item from the menu, the List Editor window appears.

Copy

This window al.lows you to enter all the data for a new entry. Each field can

Copies the selected item to the clipboard.

contain up to 200 characters, except for the Memo field which can hold up to

Paste

65,000 characters.

Pastes the contents of the clipboard into either the List window, the List
~D

Editor window, or the Layout window, depending on what type of item it is

list Editor

Header
First/ Lost
Title I Compon!J
Address 1
Address 2
Address 3
City I State

Zip/ Countr11
Phone1/2

pasting.

Memo

J
J

Clear
Clears, or deletes the selected item.

J

Select All

I

Oo(

l:hill\\l~

0~( Clear

I

)( Add )
)( Cancel )

Selects all items in a window.

Select By Example
Figure 14. AFS is ready for a new address to be typed and entered.

Displays a dialog window allowing you to select only certain addresses
in the List window that match selection criteria you specify.

To navigate through the fields you can use lhe following:
Tab - Pressing the Tab key moves to the next field.
Apple-Tab - Pressing these two keys in combination moves the cursor to the

Find...
Displays a dialog window allowing you to find and select an address in
the List window matching certain criteria.

previous field.
Mouse - You can move the arrow to the desired location and click there, and the
cursor will now be positioned at this new location.

E-16
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Displays the clipboard window and its contents,
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Windows Menu
Edit Found Address - When checked, will cause the List Editor window to apChoosing a window name from this menu makes the window front most

pear containing any found entry. If no matches are found, an alert infonning
you of this event will appear. You must then press the Continue button in this

List Menu

alert to return you to the Find window.

Insert New Address
Makes the List editor window visible and front most so that you can enter

Search Only Name Fields - When checked, causes AFS to only search for a
match in only the First Name and Last Name field. For example, if you have

a new address into the List window.

this box checked and you have typed in 'Washington', only entries whose first

Edit Address

name or last name contains 'Washington' will be found. An entry that has

Allows you to edit the one selected address in the List window by dis-

'Washington Street' for an address or City will not be found.

playing the address in the List editor window.
Additionally, there are two buttons on the bottom of the window:

Edit Return Address
Allows you to edit the return address in the List window by displaying
the return address in the List editor window.

SorL
Allows you to sort your data.base, and modify the sorting order if desired.

Find From Beginning - The first time the Find window comes open, and once
you have typed text to find, this button becomes active. Pressing this button
causes AFS to begin its search, starting at the very first entry.
Fi.nd Next - This button becomes active only after the first match has been
found. Pressing this button causes AFS to continue its search, starting at the entry where it last found a match.

Mark Printable Addresses
Marks the currently selected addresses in the List window and makes
them visible/printable in the Layout window.

Note: You may abort this function by dicking on the close box located at the
top left corner of the Find window,

Unmark Printable Addresses
Umnarks the currently selected addresses in the List window . These addresses will no longer appear in the Layout window, and will therefore not be

Show Clipboard
Displays the clipboard window and its contents.

printable.

Mark Return Address
Makes the currently selected address in the List window to be the return
address for each label or envelope in the Layout window.

C-4
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Unmark Return Address
Example 3. To select all addresses with a last name of Smith and a state of FL.

. Causes the currently selected Return Address to no longer be used. as
such, and it becomes a regular address.

1. From the List menu, choose 'Select By Example'
2. Type 'Smith' in the Last Name field.

list Info ...

3. Type 'FL' in the sate field.

Displays a dialog box with various statistics about the List, such as size.

3. Press the 'Select' button.

View Menu

Find...
Displays a dialog allowing you to find and select an address in the List

25%

Causes the screen to be displayed at 25% size.

window matching certain criteria. This window contains a field where you type

50%

Causes the screen to be displayed at 50% size.

the desired item to be found, and four check boxes:

100%

Causes tbe screen to be displayed at 100% size.

200%

Causes the screen to be displayed at 200% size.

400%

Causes the screen to be displayed at 400% size.

Find

Go To Page...

Text to find:

D Case Sensitive

Displays a dialog window that lets you specify a page number to view.

D Match Fields Exactly

D Edit Found Rddrm D Search Only Name Fields
(

Find From Beginning

) (

find Mext

)

Cells Menu
Set Cell Dimensions...
Displays a dialog box allowing you to divide the Layout's pages into labels, or cells.

Figure 13. The Find dialog.

Set Left and Top Margins ...
Case Sensitive - If this box is checked, and you type in 'McKenney', AFS will
not find entries such as 'Mckenney' or 'mcKenney' or 'mckenney'. Only exact

Displays a dialog box to adjust the margins between the cells and the left
and top edges of the page.

matches will be found.

Show Cell Boundaries
Match Fields Exactly - If this box is checked, and you type in 'Bobby', AFS
will find entries that contain a field with 'Bobby' in them, and nothing else. If

This option, when checked, displays all of the cell boundaries in the Layout window as light green rectangles for easier viewing.

an entry has 'Bobby Joe' or 'Bobby M' for a first name, it will not be found.
Note however, that unless the Case Sensitive box is checked, then a first name
of 'bobby' or 'boBBy' would also be found.

Clip Elements to Boundaries
This option, when checked, clips off any items that are overflowing the
size of your cell/label, and adjusts the display to show only what is printed on
the cell/labeL
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9. Uncheck the 'Clear List Selections' box, since we do not want to lose the

This option, when checked, arranges the List's addresses so that they pro-:
ceed from left to right, and then top to bottom along the page.

Florida.addresses we just had selected.

10. Press the 'Select' button.
11. Now all Florida and New York addresses will be selected. To mark only

Cells Go Top to Bottom
This option, when checked, arranges the List's addresses so that they proceed from top to bottom, and then left to right along the page.

these addresses for printing, from the List menu choose 'Mark Printable Addresses'

Wildcards

Elements Menu

The Select Addresses by Example window also accepts wildcards. Wildcards

Addresses
This item, when checked, displays the List's addresses in the Layout win-

extend your flexibility to select data. The wildcard indicator for AFS is the asterisk,* . You can think of the asterisk as meaning 'anything'. The concept of

dow.

wildcards is easier to explain by way of examples.

Return Address
This item, when checked, displays the List's one return address in every
cell, in addition to the normal List address.

Example 1. To select all people whose last names contain "kay"
L From the List menu, choose 'Select By Example'
2. Type *kay* in the Last Name field.

Postal Bar Code
This item, when checked, displays a postal bar code in every cell that bas
an United States address with a ZIP code.

3. Press the 'Select' button.
This would select names such as: Mckay, Kay, Milkayd, and Kayfield. The asterisks before and after 'kay' signifies that anything may precede and follow the

Picture #1
This item, when checked, displays picture #1 in each cell.

letters 'kay'.
Example 2. To select all first names that begin with 'Chris'

Picture #2
This item, when checked, displays picture #2 in each celL

1. From the List menu, choose 'Select By Example'
2. Type 'Chris*' in the Last Name field.

Picture #3
This Hem, when checked, displays picture #3 in each cell.

3. Press the 'Select' button.
Type 'Chris*' in the First name field. This would select names such as 'Christo-

Scale Pictures
Brings up a dialog window I.hat allows you to scale the horizontal and
vertical size of your picture, preview the results, and either apply or cancel.

C-6

pher', 'Christina', 'Chrissy', and 'Chris'. However, a name such as 'McChris'
would not be selected.
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Address Menu

. Example 1. To select all addresses which are from California

Choose Font...
This displays a dialog box allowing you to change the font of the selected

1. From the Edit m.enu, choose 'Select By Example'

List address or return address in the Layout window.

2. In the state field, type 'CA'
3. Press the 'Select' button.

Display as UPPERCASE
Nole that in this case anything that was previously selected in the List window

This option, when checked, displays all addresses as uppercase.

will still be selected in addition to all California addresses.

Display ZIP with +4
Example 2. To select everyone in Florida and New York then these are the
steps you would take:

This option, when checked, displays all United States addresses' ZIP
codes with the +4 extension if there is not already a +4 extension present

1. From the Edit menu, choose 'Select By Example.'
2. In the State field, type 'FL'
3. If the 'Clear List Selections' box is not checked, check it.
4. Press the 'Select' button.

The following menu items' field names correspond to the fields in every
address. If the menu item field name is checked, then the field will be displayed
within the address. If not checked, then it will be omitted.

5. From the Edit menu, choose 'Select By Example.'

Header

6. In the State field, type 'NY'

First Name

7. Uncheck the 'Clear List Selections' box, since we do not want to lose the

Last Name

Florida addresses we just had selected.

Title

8. Press the 'Select' button.

Company

9. Now all Florida and New York addresses will be selected.

Address 1
Address2

Example 3. This is a step further from the last example, in that not only do we
want all the Florida and New York addresses selected, but we also want to have
so those are the only labels that will print.

Address3

City
State

1. From the Edit menu, choose 'Select All'

Zip

2. From the List menu, choose 'Unmark Printable Addresses'

Country

3. From the Edit menu, choose 'Select By Example.'

Phone 1

4. In the State field, type 'FL'

Phone2

5. If the 'Clear List Selections' box is not checked, check it.
6. Press the 'Select' button.
7. From the Edit menu, choose 'Select By Example.'
8. In the State field, type 'NY'
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Select All
Selects all items in a window, l~ke all addresses in the List window, or all
elements in the Layout window.

Select Addresses By Example
The Select Addresses By Example dialog is identical to the list editor
window, in that an the fields are displayed. In addition to these fields the dialog
also contains a Cancel button, a Select button and a Clear List Selections
checkbox:

Select Addresses b~ Example ..,
Heed er

First I Last I
HU eI Company
Addrm 1
Address 2
Address 3
City/ State
ZIP I Country
Phm1/2

Memo

I
l

I

I

121 Clear list Selections
( Cancel ) (

Select

)

Figure 12. The Select Addresses By Example dialog.
Cancel - Pressing this button exits the Select Addresses by Example window
with no changes being made to selected or unselected addresses in the list window.

Select - Proceeds to perform the selection.
Clear List Selections checkbox - if this box is checked, then all selections in the
List window will be cleared before the selection begins. This box is checked by
default, but you may deselect it by clicking on the box. If this option is disabled,
the results of the selection, along with anything else that was previously selected, will then be selected.
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Print...
Prints the entire contents of the Layout windo.w.

Quit
Quits AFS back to the Finder.

Edit Menu
Undo
Is not implemented within AFS.

Cut
Cuts the selected item to the clipboard, whether it be a selected address
or addresses in the List window, a small piece of text in the list editor window,
or a picture in the Layout window.

Copy
Makes a copy of the selected item and puts it in the clipboard.

Paste
Pastes the contents of the clipboard into the List window if the contents
are a previously Cul/Copied address or addresses. If the contents are small
pieces of text, it can be pasted into the list editor window. If the contents are a
picture, it can be pasted inlo the Layoul window. You can copy pictures from
graphics programs to paste into AFS. You can also copy text from word processors to paste within AFS.

Clear
Clears, or deletes, a selected item, whether it be an address, a small piece
of text, or a picture.
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This section of the manual will give you a step by step tutorial on using many of
the functions in AFS. f'he tutorial folder that was installed along with the AFS

If you have an lmageWriter or dot-matrix printer...

application contains some of the files we'll be using.

For an Image Writer or other dot-matrix type printer, there are more options to

Our tutorial scenario is as follows: Susan uses AFS to keep a list of all her

observe and be aware of.

friends and families' mailing address. She uses the memo field to record each

1. Examine the box/container that your labels are packaged in and look for page

person's birthday. She does this in a standard way, so it is easy to search by.

and label size information. If the box does not provide the necessary information

Examples of her memo fields:

you will have to do some measuring yourself.

Bday Jan 10

2. When choosing a Paper type, if you cannot find an exact match, then choose a

BdayDec 9

match with the correct height for the label sheet The width can be wider than

Bday Aug 10

your actual label sheet For example, if your label sheet is 2 5/8" wide by 12"

Susan sorts her list by last name so it is listed alphabetically by last name. Susan

tall, you may choose the page size for 8 1/2" wide by 12" tall.

prints out her entire list when sending out invitations for the annual picnic party
and for sending out 'Happy New Year' cards. At the end of each month she

Note: Most label sheets designed for dot-matrix printers will be a multiple of

prints out labels to send out birthday cards to those people who have birthdays

12" in height thus choosing an 8 1/2" by 12" paper size will be appropriate for

the following month.

99% of your labeling needs. This is the default for Image Writers.

Tutorial Example A

3. We suggest you check the No Vertical Gaps option for most label sheets so
that the full height of the sheet is printable.

This example will familiarize you with the List Editor and the List window.
1. Launch AFS by double clicking on its icon.

Note: The dialog window from where you choose your page setup is NOT part
of AFS. Rather, the printer driver, which is located in your boot disk's System/

2. We will now open an existing list file from the Tutorial folder. From the File

Drivers folder, is entirely responsible for the page sizes that are presented. If

menu choose 'Open'. Go to the location where you instructed AFS to be in-

there isn't a page size which exactly matches the label forms that you own, you

stalled and find the folder AFS.Folder. Open this folder and inside you wiH find

will have to either buy an appropriate printer driver from a third party, like

a folder named 'AFS.Tutorial'. Now open the AFS.Tutorial folder and inside

Vitesse or SevenHills, or choose a page size which fits the best. The latter op-

you will find a file named ListA. Open this file.

tion should work in all cases.

3. The list window will now display the file you have just opened. Familiarize

Note: When using fanfold labels we recommend you select 'Intl Fanfold' instead

yourself with this window by scrolling through it both horizontally and verti-

of 'European A4', because European A4 is not exactly 12 inches in height,

cally. Notice the field headers near the top of the window. Also notice the check

which will eventually cause your addresses to print off the labels.

marks on the left side of the window.
4. Susan just became an aunt and she wants to add her new niece's name and

D-2
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birth date to the list, so let's do that now. From the List menu choose 'Insert
The 'Export' dialog has two additional check boxes which control the export

New Address'. The List Editor w.indow will be displayed next. Notice all the

parameters:

fields you have to work with, and the buttons available from this window.

Tabs between fields, Returns between records - puts tabs between fields and

5. Next we will enter data for some of the fields. When you are done with one

returns between records. Check this box if you will be using the exported file

field you can press the Tab key to proceed to the next one, or you can always

with other databases

use the mouse to reposition your cursor at any location. Enter the following in-

Returns between fields and records - puts returns between fields and records.

formation.

Make sure this box is checked if you will be using the exported file with word
Field Name

Information to enter

Header

<none>

First Name

Chelsea

Displays a dialog prompting you to specify the page size in the Layout window

Last Name

Williams

along with other page options. Make your selections and press the OK button to

Title

<none>

continue.

Company

<none>

processors.
Page Setup...

Address 1

123 Washington Ave

This feature corresponds exactly to the two large rectangles you see in the Lay-

Address 2

<none>

out window. The outer red rectangle is the physical size of the page while the

Address 3

<none>

inner, dark green rectangle is the total printable area within the paper.

City

Pittsburgh

State

PA

Zip

15076

Country

<none>

Phone 1

<none>

Phone 2

<none>

Memo

Bday Nov 15

Changing the page size will almost always require that you modify the number
or labels/cells to a page, which is selected from the Set Cell Dimensions ...

menu item. It is important that the page size you specify exactly matches the
page size of labels you intend to print
If you have a laser printer...

Since a laser printer only supports two page sizes, 8 1/2" by 11" or 8 1/2" by
14", any labels you purchase will come in a sheet that is either letter or legal
size. If you change from one to the other size, you might have to change the
number of labels/cells to a page. See the Set Cell Dimensions ... menu description.
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Exporl,..

list Editor

ED

Use this to export your AFS file to.an ASCII text me. This file could
Hl!lllo

Header
First I Lost Chelsea
lWil lillllls
Tit IeI Compan~
1
Address 1 123 Washington Rve
Address 2
Address 3
jPA
City I State Pittsburgh
Zip I Countr~ 15076
Phone 1/ 2
l

J

~

Bda!I Hov 15

then be imported into

an AppleWorks file. After choosing 'Export... ' AFS dis-

plays the standard put dialog where you can name the file to be exported, and
also find a location for it. Upon pressing the Save button, AFS

wm display a

window that lists each AFS field along with a checkbox. See Figure 11.
Chu~~~

)(

0~( Clear

)(

Oo(

'{}
Add )
Cancel )
fie Ids to Import or Export

l8l Header
l8l First Hame

Figure Tl. List Editor window with all fields filled in.

[8J Cit~
[8l State
[8lm
18] Countru
[8J Phone 1
[8l Phone 2
OMemo

[8]Lost Home
18]Title
181 Company
181Address1
[8lAddrm 2
lE]Address 3

6. When you're finished entering all the infonnation press the 'Add' button.
Now let's bring the List window to the front and look at where our new entry is.
Perfonn either A or B to bring the List window to lhe front

A. Click on the List window.

Formatting (export onh)

®Tabs between fields, Returns between mords
Returns between fields ond records

or

0

B. Pull down the 'Windows' menu and select 1..istA'

( Cancel ) (

OK

)

7. Notice the last entry in the List window. Notice that it is hHited and that it is
the entry you've just added. AFS places new entries at the end of the list, which
is the last entry in the List window and also selects this last entry.

Figure 1 L AFS displays this window when you attempt to save a file for export.
If a check is next to the field name, then that field will be exported. If there is no
check, then that field will be skipped when exporting. By default all boxes will

lost Home
1 Thompson
1 Thornton, RN
f Zoles
" Ziebert

listA
Rddrm 1

be checked except for the Memo field. You may deselect any of the checked
Address 2

Address 3

15223 W64th Tmo
60 Medical Center
3~35 West Market!
11050 Cooleridg~ I

. fields by dicking on the check box, thus making the check disappear. When
done making your selections press the OK button and AFS will export the file.
Note: It is not recommended that you export the Memo field. This is because the
Memo field can contain carriage returns and/or tabs which can cause undesired
results if the file is to be imported in the future. If you are careful not to put re-

Figure T2. AFS hilites a new entry in the List window.
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turns/tabs in the Memo field, then there is no problem.
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Once you match up the fields and are ready to import the file, you can save the

8. Next we will select an entry from the List window. Scroll through the List

field mapp.ing information as a template for later use. To do this, press the

window and look for an entry with a last name of Horton and a first name of

Save ... button on the bottom of the window. This will cause the standard save

Kimberly. When you see it position your cursor anywhere on that entry/row,

file dialog to appear allowing you to name the template, choose an appropriate

except on the extreme left of the entry where the check mark appears, and

location, and save it. Saving this template is very useful if you will be importing

double click. You wm see the List Editor window appear with the chosen entry

more than one AW file that has the same field names and orders, or perhaps im-

being displayed in the appropriate fields.

porting the same file a second time. Talce a quick glance to verify that the fields
are matched correctly. Then click Import. AFS proceeds to import the file and

9. This person has just moved and we need to change the address. Place your

display it in the list window.

cursor at the beginning of the field Address!, drag the mouse to select an the
text there then press I.he delete key to delete the contents. Now type '107 Walnut

Importing an ASCII text file

Tree Rd' in the Address! field.

If the file is ASCII text, AFS wiU display.a window that lists each AFS field
along with a checkbox. By default, all boxes will be checked except for the

10. Any changes you malce in the List Editor window does not automatically get

'Memo' field. You may deselect any of the checked fields by clicking on the

recorded. You must now press the 'Change' button for the changes to be re-

check box, thus toggling the check mark. When you export a file to be later im-

corded.

ported by AFS you must keep the fields in the same order that AFS displays in
the List Editor window. It is OK if you are exporting a file that is missing one

11. Now notice the four arrows present in the List Editor window. These arrows

or more of the fields contained in AFS; this is where the checkboxes come in

al.low you to scroll up and down through the list, with each entry being dis-

handy. Uncheck any AFS field that is not contained in your file to be imported

played in the List Editor window as you scroll. Experiment with pressing these

and AFS will leave that field blank.

buttons to see the results.
12. Now lets malce a change to the entry whose last name is 'Ashley'. As we

Fields to import or Export

said, the list is sorted (therefore displayed) by the Last name field, in increasing

[8l Header

181 City

[81 First Hmu
r;81 last Name
[81 Title

[81 State

order. We therefore would expect to see a last name of Ashley towards the top

181m
18.1 Countrg

of the list To quickly go to the top of U1e list, and have that ent.ry displayed in

l'.81 Company

the List Editor window, press the 'move to the top' button (see Figure T3.)

181Phon~1

t8]Addms 1

1'81Phone2

l2l Address 2

0Memo

181 Address 3

formatting (export onh)
i:!,1 fobs tiet11t•Ni liel<ls, R~turns bet~ii~en mcrds
()Returns betNm fal ifs und imrds
( Cancel )

OK
Figure T3. From left to right these buttons will move up one, move down one,

Figure 10. If an item is checked, then it signifies

move to the top, move to the bottom.

that it is contained in the file to be imported,
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13. Notice the last name entry that appears at the very top of the list window is
'Amieka'. We wanted Ashley, so dick on the 'move down one' button to go
down one entry. Now the last name reads Ashley. Change the Address1 field so
that it reads '8701 Apple Lane'. To record the change, press the 'Change' button. If you had not pressed the 'Change' button, and used one of the arrows to
scroll to another entry, you would have lost your changes.
14. Susan received news that one of her relatives has passed away, and she
wants to remove this entry from her list so that she does not accidentally send a
birthday card to that person next year. We will show you how to easily do this
from the List window. Click on the list window to bring it to the front Now
scroll through H while looking for a last name of Zales and a first name of

m Records

Import App leWorks Database Fil es ...

AppleWorks ---"'
First Home
Lost Name

(

(3) PHOHE
(4) FJmHAHE

Title

(5) LAST NAME

Compons

(6) (7) ADDRESS

Address 1
Address 2
Addrm 3

mcm

(9) ST
(10) ZIP

Cit~

! Header

PROFILE

( Cancel )(

-0-

State

Open ...

)( Save ... )

~

(

Import

)

Myron. When you find it, click on it once to select it, and then press the delete
key on your keyboard. This wm delete the entry. Alternatively, instead of press-

Figure 9a. This dialog allows you to define how

ing the delete key you could have chosen 'Clear' from the Edit menu.

AppleWorks fields are to be imported into an
AFS list.

8. Let's save the file with all the new changes. From the File menu choose
'Save'. Your file will be saved immediately. To quit AFS choose 'Quit' from
the File menu.

Tutorial Example B
Cooipony
Address 1
Address 2
Address 3

This example will familiarize you with the Sort function available while in the
List window.

(5) LAST HRME

AFS sorts lists on demand. This simply means that if you want to make sure

(6) (7) ADDRESS

your list is sorted you musl specifically tell AFS to do so. If your list is sorted
and you add a new entry, this entry is added to the bottom of the list, which
more than likely will cause your list not be sorted anymore. By adding a new
entry to her list, Susan realizes that it is no longer in order. However, she has

Cit~

mcm

State
ZIP

(9) ST

cm m

Country

FIRST MAHE

( Cancel )(

Open ...

)

Phone 1
Phone 2
v

mport

decided that she would actually prefer to sort the list by First Name and secondarily by State. We will show you how to sort the list
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Figure 9b. The first name fields are being matched up.
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Tutorial
Note: In order for the Import menu item to be active you must have a list
file open. This list file can be one iliat was just created and contains no

i~forma

1. Launch AFS and open ListA. Now from the List menu choose 'Sort'. You
will see the following window come up on your screen.

tion. However, if you have a Hst file currently open and then you proceed to Import another file, the file being imported wm be appended to the me currently
displayed in the list window.

Change List Sorting Order ...

Importing an AFS List

(2) First Home

1) If the file is an AFS list, then there will be no further prompts. The contents of

the imported file are appended at the end of the List currently open in AFS. All
entries in the newly imported file will be selected, and marked as printable.

(3) Address 1
(~) Address 2
(5) Addri!ss 3
(6) City
(7) State

9

mm

(10) Phone 1
(11) Phone 2

2) If the file is an Apple Works database, the dialog window shown in figure 9

(12) Header
(13) litl!!

Down One

{)Down Five

(9) Country

Importing an AppleWorks database

will appear. The list on the left contains the field names of the AppleWorks file.

"(}Up five
0 Up One

( Cancel )

D Postal Bulk son

(

Sort

)

The list on the right contains the field names available in AFS. More than likely,
the fields will not be matched up correctly, since AFS matches the first field in

Figure T4. The Sort window.

the AppleWorks file with the first field in AFS and so on.
To change the matching arrangement you must first select one of the AppleWorks
entries shown in the scrollable list by dicking on it It will become hilited. Next,

Notice the order of the field names in the scrollable window that appears in the
left portion of the sort window. This is the order that is currently set up for AFS
to sort in. That is, AFS sorts by Last Name, then by First Name, and so on.

notice the pop-up menu below and to the right of this scrollable window. It will
have the name of the AFS field that is currently matched with the selected AW

2. The first thing we must do is move the field 'First Name' to the top of the

field. To change the AFS field, press and hold down the mouse button. A menu

list Select the field name 'First Name' by clicking on it once. Now press the

listing all AFS fields will appear. Drag the mouse so that the arrow moves up and

arrow button labeled 'Up One'. Notice that the field name has moved up one

down this menu, and you will be able to see all the AFS fields. Once you have the

position, and is now the first one on the list. This is exactly what we wanted.

arrow on the desired AFS field, and it is hilited, you can release the mouse button

Now we want the 'State' field to become the second one. Select the State field

and your new selection will have been made. Verify the change on the scrollable

and then press the button labeled 'Up Five' to move it up five spaces.

window.
You may now select the next AW field you want mapped differently and repeat
the process. Note that there is also a <None> option for AFS fields. By choosing
<None> you wiU effectively eliminate the AW field from being imported into the
AFS list file.

E-4
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Reference
When you have located the file you want to open, simply double click on it; or

Change List Sorting Order ...
(1) First Heme

-fr

open the AFS list or layout file, and display the infonnation in either the layout

tJ Upfi11@

(3) Last me
Address 1
(5) Address 2
(6) Addrm3

m

Q

Up One
Down One

0
--!} Down Five

(7) City
(8) ZIP

(9)
(10)
(11)
(12)
(13)

select it by clicking on it once, and then click on the Open button. This wiU

Country
Phone 1
Phone 2
Header
Title

( Cancel )

(

Sort )

window, or the list window.

Close
Closes the front most window. If the window is a List or a Layout window, AFS wm ask you if you want to save your work before closing.

Save
Saves the current List or Layout session, depending on which of the two
windows is front most It is important to note that the List and the Layout are

Figure TS. The sort window after the sorting order has been changed.

saved separately. That is, you store your List in one file and your Layout in another. This arrangement is so that you can have many different Layout tem-

3. Now we have set up how we want AFS to sort our list Press the 'Sort' button

plates for a single List. If this was a new file, you will be prompted to name it.

for the actual sort to take place. When AFS is done it will return you to the list

At that point you may also place it in a different location.

window. Notice the column headers in the list window have changed positions.
Scroll through the window to see the results of the sort.

4. Susan has decided she preferred the old sorting method better. So, change the
sorting order to the following and sort your list once more:

Save As..•
Same as Save, but allows you to specify a new file name. At that point
you may also place it in a different location.

Last Name
Import"°.

First Name
Addressl

Displays a standard file dialog box, prompting you to choose a file to

AAddress2

import into the current List. The types of files AFS will import are: 1)

Address3
City

AppleWorks Classic database, 2) AFS lists, and 3) ASCH text files. Theimported file will be added to the current List and all of the imported addresses

State
Zip
Country

will be selected. AH entries in the newly imported file will be selected, and
marked as printable.

Phonel
Phone2
Header
Title
Company
Memo
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5. When you're done with the sort save your file and proceed to the next ex-

New
Displays a dialog box asking whether to begin a new address database
List, a new page Layout template, or both. See figure 7. By default, both boxes

ample.

Tutorial Example C

are checked. If you do not wish to open both a List and a Layout, then uncheck
the undesired item by clicking on it. The Cancel button allows you to exit the

This example will familiarize you with the Layout window, and also some new

function without starting any new files.

features from the List menu. In this example we assume you have an
ImageWriter printer. If you have another you can still go through the example.
You must have completed Example A before proceeding with Example B.

Start a new session...
Background Information: It's the end of November and Susan wants to print out

l8l List

~
~

labels for people with December birthdays. The first thing she needs is a layout
window. AFS provides you with templates for some of the more popular label
sizes. Susan has gone to the office supply store and bought some A very labels

[;]Layout

#4241. These labels are actually meant to go on 3-1/2" floppy disks, but Susan

( Cancel ) (

Hew

)

likes to use them for her birthday mailings because they're much roomier than
the usual address labels and she can put a nice birthday picture on her label.

Figure 7. Choose the type of new file desired from this window.

1. When you installed AFS you also installed a folder named 'Avery.Layouts'.
Since Susan is using A very labels, she will check to see if a layout template for

Open ...
Displays a standard file dialog box (see figure 8) allowing you to choose
a List or a Layout file to open.

this label is included in iliat folder. From the File menu choose 'Open'. You
must now locate the Avery.Layouts folder and open it Next open the file named
'ImageWriter'. A list of layout files will be displayed. Scroll through the list and
find the file named 'A very .4241 '. Notice thal I.his is tl1e same number on
Susan's box of labels. Select the file and open it.

Open which list or lo!}out?
l:f) (iill AFS. v1.0 (ProOOS)
l!flt!i:J')u1: J~'l.!.ll!!lll
G;J Icons

-fr

(

Disks

)

We muset up our page size now. From the File menu choose 'Page Setup'. For
Paper Type choose Intl Fanfold ... .8'' x 12". For Reduction choose Full Size. For

(

-0!

Open

)

( Close )
( Cancel )

Height have both the No Vertical Gaps and the Vertical Condense boxes
checked. Press the OK button.
3. Next the layout file will display all of your entries in the labels. What is displayed in your layout file would be exactly what would get printed, but don't

Figure 8. The standard dialog for opening a me.

E-2

worry about how the layout looks. But wait!! The layout is IO pages long, it
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includes an entries from List A - yet we only want to print labels for those
people with birthdays in. December. We will take care of that in the next step.
4. First, let's return to the List window. From the Windows menu choose
'ListA'. TI1is brings up the List window. What we must do now is to select the
desired birthdays and mark them for printing. Notice once again the check
marks on the left side of each entry. Each check mark signifies that the corresponding entry is 'marked' for printing. All of our entries have check marks by
them, and that is why they are all included in the layout, because they're 'printable'. Take the following steps in order to get the results we want
a. Select all the entries in the list window. Do this by choosing 'Select
All' from the Edit menu.
b. Now we will mark the entries as not printable. To do this pull down
the List menu and select 'Unmark Printable Addresses'. Now notice that all of
the check marks have disappeared. By using the Windows menu as shown before, take a look at the Layout window, named Avery.4241, and verify that
there are no addresses there to be printed, and then return to the List window.
c. We must now select all entries that have 'Bday Dec' in the memo
field. From the Edit menu choose 'Select by Example' . The Select Addresses
by Example window will appear. This is where you specify what addresses you
want to select. Go to the memo field, and click there so that the cursor shows up
in that field. Next, type '*Bday Dec*'. Yes, you must include an asterisk before
and after the text to be found/selected.
You can read '*Bday Dec*' as meaning 'anything, then Bday Dec, then anything'. If we had simply entered 'Bday Dec', AFS would only find/select those
entries that have exactly 'Bday Dec' in them, nothing more, nothing less. So if
an entry contained a period after Dec then it would not. be found/selected. The
asterisk is called a 'wildcard' and the reference section explains wildcards with
more details.
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Now press the Select button. When AFS is done with the selection it will bring
the List window to the front Be C3!eful not to click in the list window, since this
~D

Bday.lo~out

Horiz:

~

13132"

Vert: 0 31132"

0<? 4' <!>- ?O

Pog~:

1 of

~~ t~a~! ~ID!i

would cause you to accidentally select the entry just clicked on, and you will
lose the selections we've just made. Scroll all the way to the right so that the
Memo field is showing. Now scroH up and down and notice that all entries wiili
'Bday Dec' in the memo have been selected.
d. Now we must mark all the selected fields as 'printable'. From the List

--E I

menu choose 'Mark Printable Addresses'. Now go to the layout window and
notice that the only addresses showing are those with 'Bday Dec' in the memo
field.

Co !lttn iurb1nk

11J82 lmr ly P!1c1
Llkt forest IL 600~5

5. While the layout window is in the front, select Save As from the file menu
and save your layout file as Bday.Layout, placing it in the AFS.Tutorial folder.
Close the layout file.

Figure TI. Layout window after all pictures have been pasted
and all elements have been arranged.

6. While we're at it, save the list file (do not rename it).
7. Now we'U add a picture to our labels. Open the layout file 'AFS.Pict'. This

13. That's it! You can now quit AFS and you're done with the Tutorial. We
have not covered everything available in AFS with this Tutorial, but you should
now have a good basic understanding of how things work. The Reference section contains more information on the features of AFS, so be sure and look

file is located in the tutorial folder and it contains three pictures. The layout itself is not important; this file is solely so that you can copy one of the pictures
there for use with this tutorial. Normally, you can use a program like
AppleWorks GS or Platinum Paint to create pictures.

through it when you have an opportunity.
When the AFS.Pic! file is displayed in the layout window you will see three pictures shown in the label; a picture that says 'Happy Birthday!', a birthday cake,
and a plain black border/rectangle. Select the 'Happy Birthday!' by clicking on
it. You will see a gray rectangle appear around it. This signifies 1l1at it has been

selected. From the Edit menu choose 'Copy'. Now close this layout file by
clicking on the little close box at the top left corner of the window.
8. Open the layout file Bday.Layout. From the Edit menu choose 'Paste'. You
will see the 'Happy Birthday!' appear on the layout window. Don't worry that

the entire 'Hayppy Birthday!' picture is not visible. We'll explain shortly.
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Tutorial

Notice the green outlines in the layout page. These green outlines represent the
size and position of the labels. It is your .choice whether you like to have the label outline showing or not. To see how this works, choose 'Show Cell Boundaries' from the Elements window. You have just toggled Show Cell Boundaries
off, so they will not be displayed. Go back and toggle the cell boundaries back
on so that we can see the outline of the label.

Horiz:

~ 316~"

Vert: 0 13/16"

r{>0

Page:

1 of

~tttuma~! ~:ill~
---

Now also notice how our picture seems to disappear right where the label outline appears. The reason for this is that we have 'Clip Elements to Boundaries'

Co llt1n l<Jrbink

toggled on in the Cells menu. This is a very helpful function because it shows us

!238l l!I'!! ly Pl?JCI
Lill.! !ortSt IL 6-0045

that our picture is falling off the edge of the label. From the Cells menu toggle

0~ ~?

'Clip Elements to Boundaries' off and observe the resulls in the layout window.
Toggled it back on when you're done observing.
Figure T6. Layout window after the 'Happy Birthday!' and cake
Now select the address and, by dragging the mouse, move it to the lower portion

pictures have been pasted.

of the 'label'. Next, select the 'Happy Birthday!' picture and drag it to just above
the address. You should now be able to see the 'Happy Birthdday' picture in its

11, The border should be selected by default, but if you accidentally deselected

entirety.

it, select it now. From the Elements menu choose 'Scale Picture'. Delete the 100
shown in both the horizontal and vertical scaling and type in 75 for both. Press

9. Hmmm, there is still room on the label - let's add that birthday cake.
a. First, save the Belay.Layout file.
b. Next, open the AFS.Pict file.
c. Select the birthday cake and copy it.

the Preview button and see what happens. Next, press the Apply button. AFS
will scale the picture and return you to the layout window. Now reposition the
border so H fits nicely around the address and it actually mimics some of those
address labels you can purchase at the store. You might have to scroll down to
see the rest of the label and position your elements properly.

d. Close the AFS.Pict file.
e. Open the Bday.Layout file and paste the birthday cake there,

12. We're almost done. Save the layout file and print it by choosing 'Print' from

f. Reposition your elements so that the cake is to the right of

the File menu. Of course, you won't have the proper labels in your printer but

'Happy Birthday!' and the address is nicely centered underneath

this will give you an idea of how things will look whe.n printed.

both pictures. See Figure T6.

10. Well, the label looks real nice now, but if we could put that nice border
around the address it would look extra special. Repeat steps 9a-9d, but copy and
paste the border/rectangle instead of the birthday cake. You will notice that the
border doesn't quite fit right We'll take care of that in the next step.
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